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1. Preliminary Steps before Transcribing 
 
 
Before you are able to start transcribing a Greek manuscript, you will need to ensure that: 

• Your operating system will support Unicode. 
• You have an appropriate Programme loaded. 
• You have downloaded Gentium, the best Greek polytonic Unicode font for transcribing. 
• You can switch between a American/British keyboard and a Greek polytonic one. 
• You have access to the Character Palette (Mac) or Character Map (Windows). 
• You have downloaded an appropriate base text. 
• You have downloaded an appropriate Items for Copy and Paste document. 

 
Each of these points, including instructions on use where necessary, will be addressed in this first 
section. 
 

1.1 Operating Systems 
 
In this section, there are instructions for preparing to transcribe using Macintosh and Microsoft 
Windows operating systems. All transcriptions must be Unicode compatible, which means that your 
operating system must provide Unicode support. Macintosh has included Unicode support since 
version 8.5. Microsoft began supporting Unicode with Windows NT 3.1 and Windows 95. 
 

1.2 Programmes 
 
Transcriptions can be made in any of the following programmes: jEdit, BBEdit or Microsoft Word.1 
Separate instructions for using Microsoft Word (on a Mac and a PC) for transcribing are currently 
available; IGNTP transcribers should contact either Bruce Morrill (US) or Rachel Kevern (UK) for 
a copy of these instructions (see 8.6 Contacts for email addresses). 
 

1.3 Font 
 
The process of transcribing requires that you use a Greek polytonic Unicode font. One advantage of 
using a Unicode font for transcribing is that you can switch between English and Greek without 
changing fonts. Another advantage is that you can choose from a range of Greek polytonic fonts, 
some of which are more complete, and more attractive, than others. 
 
The best font for our purposes is Gentium, which has both Windows and Macintosh versions. It is 
recommended that you use this. It is attractive and easy to read in English and Greek and contains 
all the various symbols needed for a transcription.2 
 

                                                             
1 BBEdit and Microsoft Word must be Unicode compatible versions. 
2 Gentium does not include Greek numerals.  
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Gentium is freely available on the Internet from 
http://scripts.sil.org/cms/scripts/page.php?site_id=nrsi&id=FontDownloadsGentium  
 
Click on ‘Download main Gentium fonts’. Scroll down the page and under ‘Download’ and click on 
the relevant link for your operating system, and follow on-screen instructions. Note that once the 
package has been downloaded, you will need a decompression utility such as WinZip (Windows) or 
Stuffit Expander (Macintosh) to expand the archive. Mac OS X will automatically expand the 
archive. Windows XP has a built-in archive expander. Within the archive are the font files and a 
Read Me. The Read Me includes basic instructions for installing the fonts.  
 

1.4 Switching Keyboard Layouts 
 
In order to be able to input Greek characters in your transcription you will need to add a Greek 
keyboard layout.  
 
1.4.1 Macintosh OS X 
 

1. Go to System Preferences>International>Input Menu. Scroll down and tick the box next to 
‘Greek Polytonic’: 

 

             
 

At the bottom of the ‘International’ screen, tick ‘Show input menu in menu bar’. A little 
American or British flag will appear in the right-hand corner of the menu bar at the top of 
your screen, depending on your default input language.  

 
To write in Greek you can either: 
 

a) Click on the flag, then click on ‘Greek Polytonic’ and start typing. To revert to writing 
English open again and click on ‘U.S.’ or ‘British’. 

 
Or: 
 

b) Use a keyboard shortcut to switch between the American/British keyboard and the Greek 
Polytonic one. This option is the quickest and easiest and is recommended. The keyboard 
shortcut is Command + Space. If the keyboard layouts don’t switch when you key this 
shortcut, you need to change the default settings. Go to System Preferences>Keyboard and 
Mouse. Scroll down the list of shortcuts and check ‘Input Menu’ and uncheck ‘Spotlight’ 
(which is the default keyboard shortcut on some systems):  
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This will allow you to switch between the American/British keyboard and the Greek Polytonic one 
by typing Command  + Space.3 

 
It can also be helpful to be able to view the keyboard layouts in order to find which keys relate to 
which Greek characters.4 To do this, go to System Preferences>International>Input Menu and 
check ‘Keyboard Viewer.’ To view the keyboard layout, go to the flag on the menu bar and click 
‘Show Keyboard Viewer’. If you are in Greek Polytonic mode, the keyboard that appears will show 
you the position of the various Greek characters on your keyboard. If you press Shift, Shift and Alt, 
or Alt, while viewing the keyboard layout, the positions of these characters will also be displayed. 
 
1.4.2 Windows Vista 
 

1. Go to Start>Control Panel>Clock, Language, and Region>Change keyboards or other input 
methods. 

2. In the ‘Regional and Language Options’ window, open the ‘Keyboards and Languages’ tab 
and click ‘Change keyboards’. 

3. In the ‘Text Services and Input Languages window, open the ‘General’ tab and click on 
‘Add’ under ‘Installed Services’.  

4. Scroll down the list of languages and click the little box next to ‘Greek’ and a ‘Keyboard’ 
checkbox opens. Click the little box next to ‘Keyboard’ and check ‘Greek Polytonic’. Click 
‘OK’. 

 

                                                             
3 If you have more than two keyboard layouts in use, use Command + Space to select previous input source and 
Command + Option (alt) + Space to select the next input source.  
4 General Keystroke tables for Gentium Greek Polytonic can also be found in the Appendix. 
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5. Back on the ‘Text Services and Input Languages’ window, open the ‘Language Bar’ tab. 
You can select where you wish the Language Bar to appear. The default position is ‘Docked 
in the taskbar’. 

 
To write in Greek you can either: 
 

a) Click on the EN icon in the taskbar, then select ‘EL Greek’ and start typing. To revert to 
writing English click on the EL icon and select EN. 

 
Or: 
 

b) Use a keyboard shortcut to switch between English (US or UK) keyboard and the Greek 
Polytonic one. This option is the quickest and easiest and is recommended. The default 
keyboard shortcut is Left Alt + Shift. If Left Alt + Shift does not work on your computer, go 
to Start>Control Panel>Clock, Language, and Region>Change keyboards or other input 
methods. In the ‘Regional and Language Options’ window, open the ‘Keyboards and 
Languages’ tab and click ‘Change keyboards’. Select the ‘Advanced Key Settings’ tab. 
Under ‘Hot keys for input languages’ you will see the key sequence required to switch 
between input languages. 
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1.4.3 Windows XP  
 

1. In the Windows XP standard Start menu, go to Start>Control Panel. In the Windows XP 
classic Start menu, go to Start>Settings>Control Panel.  

2. Double-click ‘Regional and Language Options’. Click the ‘Languages’ tab, and under ‘Text 
Services and Input Languages’ click ‘Details…’  

3. Under ‘Installed Services’ click ‘Add…’ to go to ‘Add Input Language.’ 
4. From the ‘Input language’ drop-down menu, select ‘Greek’. From the ‘Keyboard 

layout/IME’ drop-down menu select ‘Greek Polytonic’ and click OK.  
 

       
 

You will be taken back to the ‘Text Services and Input Languages,’ click ‘Apply’. 
5. Under ‘Preferences’ click ‘Language Bar…’ Check that ‘Show the Language bar on the 

desktop’ and ‘Show additional Language bar icons in the taskbar’ have ticks against them 
and click OK. If they don’t already have ticks against them, tick them and click ‘OK’.  

 



 8 

       
 
6. Back on the ‘Text Services and Input Languages’ box, click ‘Apply’ if necessary. (If 

‘Apply’ is very pale there is no need to do this). A little keyboard icon (EN for English) will 
show on the taskbar at the bottom of the screen. 

 
To write in Greek you can either: 
 

c) Click on the EN icon, then select ‘EL Greek’ and start typing. To revert to writing English 
click on the EL icon and select EN. 

 
Or: 
 

d) Use a keyboard shortcut to switch between the English keyboard and the Greek Polytonic 
one. This option is the quickest and easiest and is recommended. The default keyboard 
shortcut is Left Alt + Shift. If Left Alt + Shift does not work on your computer, go to 
Start>Control Panel (or Start>Settings>Control Panel), double click on the ‘Regional and 
Language Options’, click on the ‘Languages’ tab, ‘Details,’ and under ‘Preferences’ select 
‘Key Settings.’ Under ‘Hot keys for input languages’ you will see the key sequence required 
to switch between input languages. 
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1.4.4 Windows 20005 
 

1. Go to Start>Settings>Control Panel. 
2. Double-click ‘Regional Settings’. 
3. Click the General tab, click to select the check box next to the appropriate language group 

you wish to install, and then click Apply. The system will either prompt for a Windows 
2000 CD-ROM or access the system files across the network. Once the language is installed, 
Windows 2000 will prompt you to restart the computer. 

4. Again go to Start>Settings>Control Panel. 
5. Double-click ‘Regional Settings’. 
6. Click the Input Locales tab. 
7. In the Input Locales box, click the Greek language, and then click Properties. 
8. In the Keyboard Layout box, click the Greek keyboard layout, click OK, and then click OK. 

 

1.5 Character Palette/Map 
 
You may want to manually add certain characters to your transcription that are not available on a 
regular keyboard, such as overlines and underdots.6 In order to do that, you will need to be able to 
copy and paste them from a palette of characters.  
 

1.5.1 Macintosh OS X 
 

1. Go to System Preferences>International>Input Menu. Tick the box next to ‘Character 
Palette’ and close box:  

 

             
 

2. To view the character palette, click on the American/British flag on the menu bar and click 
‘Show Character Palette’.  

3. At the top of the ‘Characters’ window, select ‘Code Tables’ from the drop down menu of 
‘View’ and select ‘Unicode:’ 

 

                                                             
5 This information about installing the Greek keyboard layouts using Windows 2000 is from 
http://www.biblicalgreek.org/links/fonts/keyboard.html. I have not checked the accuracy of this information.  
6 Tags, entities and other characters that might be needed for the transcription are also available for copy and paste, see 
1.7 Items for Copy and Paste Document. 
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4. Make sure that ‘►Character Info’ and ‘►Font Variation’ are opened by clicking on the 
arrows: 

 

             
 
You are now ready to add Unicode characters. If you want to find a Unicode character that is 
required in your transcription: 
 

1. Type the number, for example 0305 – the combining overline,7 in the little window at the 
bottom and click on the magnifying glass. Either the character will appear, or a choice of 
characters may appear, as: 

 

               
 

2. Double click on the Unicode one (in this instance, the combining overline) and it will appear 
in the ‘Character Info’ box: 

 

             
 

                                                             
7 You will be given the necessary Unicode characters references later in this document. 
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3. Place your cursor after the letter in your transcription that you wish to modify and click once 
on the modifying character in the box on the left under ‘Character Info’. It should appear in 
your transcription. If it doesn’t, it can be dragged and dropped. 

 

1.5.2 Windows Vista and XP 
 
The Character Map may already be visible in your Start menu. If it is not: 
 

1. Go to Start>All Programmes>Accessories>System Tools>Character Map. 
2. Select ‘Gentium’ in the ‘Font’ drop-down menu. 
3. Check ‘Advanced view’ and then select ‘Unicode’ from the ‘Character set’ drop-down menu 

and ‘All’ from the ‘Group by’ drop-down menu.  
4. To find a Unicode character that you require for your transcription, type in the number, for 

example 0305 – the Combining Overline – in the ‘Go to Unicode’ box. The correct character 
will be highlighted in the table of characters: 

 

               
 

5. Either double-click on the highlighted character or click ‘Select’ and it will display in the 
‘Characters to copy’ box (though it may be difficult to actually see if it is something like a 
single combining overline). You may select a series of characters in this manner, such as a 
theta, a nu and a combining overline to create ‘θν̅’. 

6. Click on ‘Copy’, go to your transcription and place your cursor after the letter in the 
transcription that you wish to modify and select ‘Paste’ from the Word Edit menu or Ctrl + 
V. Alternatively, you may copy characters by dragging them from the Character Map and 
dropping them into your open document. 
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1.6 Base Texts 
 
To begin a transcription, you will need a base text.  
 
A base text is an existing electronic text against which you will compare a manuscript text. In order 
to read a base text correctly, you will need to have already downloaded the Gentium font. Each 
individual manuscript differs from the base text. You will change the base text so that it matches the 
manuscript you are reading exactly and rename the base text with the name of the manuscript you 
are transcribing. The base text is arranged according to chapters and verses, with the book number 
also recorded at the beginning. 
 
At the top of the base text is a status note form which is to be filled in, initially by the transcriber, 
providing some basic information about the transcription itself and major features of the text to be 
transcribed. It is later used to add information relevant to the processing of the transcription. 
 
IGNTP transcribers should contact either Bruce Morrill (US) or Rachel Kevern (UK) who will 
email you the correct Unicode base text (see 8.6 Contacts for email addresses).  
 
Currently, the Unicode base texts contain the TR (Textus Receptus)8 and they are without accents, 
breathing marks or punctuation.9 They use the nomina sacra in their most common forms. Note that 
final sigma (ς) is used in the base texts and should also be used in your transcription. On the Greek 
Polytonic keyboard, ς is located at the ‘w’ key. 
 

1.7 Items for Copy and Paste Document 
 
In the process of creating a transcription, you will need to add tags and entities that provide the user 
with certain information (tags and entities will be discussed further in the next three sections) about 
the text you are transcribing. These can be simply typed. The disadvantage of typing them is that it 
is easy to introduce error. It is recommended that you copy and paste material from a document 
called Items for Copy and Paste, which is available from your supervisor. All of the tags, entities, 
punctuation and other symbols you are ever likely to need can be copied from this document and 
pasted into your transcription. In order to read this document correctly, you will need to have 
already downloaded the Gentium font. 

                                                             
8 Also known as the Received Text, see ‘Received Text’ in Glossary. 
9 There are occasional exceptions: they are recorded when the accenting/breathing alters the meaning of the text, see 
5.7.2. Accents and Breathing Marks. 



 13 

2. Reference: Symbols and Example Page 
 

Frequently Used Symbols 
 
Block Markers 
 
<B 00>     (Book number) 
<K 00>     (Chapter number) 
<V 00>     (Verse number) 
 
Tags  
 
There should always be a space between the letter and the following number in the following tags: 
 
|F 000r|    (Folio number; recto)  
|F 000v|    (Folio number; verso) 
|P 000|    (Page number) 
|C 0|    (Column number) 
 
There should be no spaces within or between the following tags, or between the tag and the word or 
words that are being tagged: 
 
|L|    (Line) 
[º][\º]    (Alt + o    Lacuna) 
[ill][\ill]10    (Illegible) 
[app][*][\*][C][\C][\app]      (First hand and corrector) 
[app][*]&om;[\*][C][\C][\app]      (First hand omission and correction) 
[app][*][\*][C*][\C*][\app]      (First hand and first hand correction) 
[app][*][\*][C1][\C1][\app]      (First hand and corrector 1) 
[app][*][\*][C2][\C2][\app]      (First hand and corrector 2) 
[app][*][\*][C3][\C3][\app]      (First hand and corrector 3) 
[app][*][\*][K][\K][\app]      (Text and commentary reading) 
[app][*][\*][A][\A][\app]      (Text and alternative reading) 
 
Entities 
 
&om;    (Omission)                           &lac;     (Lacuna) 
 
Other Symbols, etc. 
 
{om}    (Omission) 
 
=    (simply ‘=’ or on a Greek keyboard Alt + =     Word break) 
 
̅    (Combining overline: Unicode 0305) 
̣    (Combining dot below: Unicode 0323) 
                                                             
10 The ‘illegible’ tag is not used by INTF transcribers. 
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Example Page 
 
|F 1r|11 
|C 1|    or 
{|F 1r||C 1|} 
|L|<B 23> <K 4> <V 11> &lac;12 
|L|ο [app][*]θς̅[\*][C]υς̅[\C][\app] ταπρισεν η[º]μας και ημεις[\º] 
|L|οφιλομεν αλλ̣η̣[º]λους αγαπαν[\º]  
|L|< V 12> {om} < V 13> ουδεις ποποτε τ[º]εθεαται[\º] 
|L|τον ειν εαν αγαπ̣[º]ωμεν αλλη[\º]= 
|L|λους ο [app][*]δα[\*][C*]ηλιας[\C*][\app] ε ημιν [º]μενει και η α= 
|L|γαπη[\º] α̣υ̣του τ̣[º]ετελει= 
|L|ωμενη[\º] &lac; {4.13} 
|F 1v| 
|L|<V 14> &lac; 
|L|απε[º]5-7[\º]ο [º]υιον σωτη= 
|L|ρα του κοσμ[\º]ο̣υ <V 15> [º]ος εαν ομολο= 
|L|γηση οτι ιη̅[\º]ς ε̣[º]σ[\º]τιν ο̣ [º]υ[\º]ς̅ του̣ 
|L|[º]θυ̅ ο θς̅ εν[\º] αυτ̣ω μενει και 
|L|[º]αυτος εν αυ[\º]τ̣ω ε̣στι̣ <V 16> και [app][*]ημε[\*][C]ημεις[\C][\app] 
|L|[º]εγνωκαμε[\º]ν κα̣ι πεπιστευκα= 
|L|[º]μεν την[\º] αγαπην ην εχι ο χρ̅ς 
|L|[º]εν ημιν ο θ[\º]ς αγαπη εστιν κα[º]ι[\º] 
|L|ο μενων ε[\º]ν̣ τη̣ αγαπη εν 
|L|[º]θω̅ μενει και ο θ[\º]ς εν αυτω̣ μ̣[º]ενει 
|L|παντας ειπεν τ[\º]ο̣ις μα̣θ̣ητα[ill]ις αυτου[\ill] 
|L|<V 17> [º]οιδατε[\º] οτι [ill]3-4[\ill]13 γενo= 
|L|[º]μενας[\º] &lac; {4.18 end} 

                                                             
11 Those not including page layout information in their transcriptions should ignore the folio and column number tags 
(|F 1r| and |C 1|) and line break tags (|L|). 
12 &lac; here means that the entire line of text is missing because the parchment itself is missing. 
13 The base text here reads μετα δυο ημερας παντας which doesn’t fit the space available here, so an approximate 
number of illegible letters has been added between the [ill]…[\ill] tags. 
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3. Preparing a Transcription 
 
 
Having added the Greek keyboard and character palette/map and downloaded Gentium, a base text 
and the Items for Copy and Paste document, you are ready to begin a transcription. First, it is useful 
to understand several important terms frequently used in text editing: 
 

3.1 Important Terms 
 
Tag  A tag is a control character which provides the programme with important 

information for the editing of the text. Tags consist of an opening element 
and a closing element that surround the text, for example, [*]ιησους[\*]. The 
closing tag corresponds to the opening tag, but with the addition of ‘\’ a 
Reverse Solidus. Tags always begin and end with square brackets [ ]. 

 
Block Marker Block markers flag the beginning of books, chapters and verses. They consist 

of ‘<’ a Less-Than Sign, a capital letter (B = Book, K = Chapter, V = Verse), 
a space, a number and a ‘>’ a Greater-Than Sign. For example, <B 04> 
means Book 4 (John). It is important that these block markers remain in 
exactly the same form throughout the transcription. 

 
Line Break Line breaks flag the beginning of a new line in the manuscript being 

transcribed. They are tagged as |L|.  
 
Entity An entity is a marker that shows you something about the text, for example, 

that it has been omitted by the scribe, or that it is missing due to loss of 
physical material. An entity begins with an ampersand, ‘&’ and ends with a 
semicolon ‘;’ (e.g. &om; for omission) thus distinguishing the characters 
within the & and ; from the actual text.  

 

3.2 Naming the Transcription 
 
The first thing to do in any transcription is to name the transcription file.  
 
The name consists of a document number (for example 04 for John, John being the fourth book of 
the New Testament), a six digit number depending on the type of manuscript (see below), and the 
initials of the transcriber, all separated by low lines (Shift + -). The six-digit number consists of 
three parts: 
 

 Type of Manuscript Manuscript Number Supplement14 
Example: 1 0074 0 
Possible options: 1 = Papyrus 

2 = Majuscule 
3 = Minuscule  
4 = Lectionary 

Always four digits. Fill 
missing digits with zero. 

0 = text written by first 
hand(s) 
1 = supplement 1 
2 = supplement 2, etc. 

                                                             
14 See 6. Supplements and ‘Supplement’ in Glossary. 
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The manuscript number is the Gregory-Aland number that has been assigned to all New Testament 
manuscripts. So, as an example, if I transcribe John from a minuscule with the Gregory-Aland 
number 156, I give it the file name 04_301560_rk.  
 
To name your transcription, open your base text and click on ‘Save As’ in the ‘File’ menu. Type the 
name of the file and where you want it saved. 
 

3.3 Status Note 
 
As well as a base text, you will have downloaded a status note form. This should be copied and 
pasted into your transcription file at the beginning, before the first block marker.  
 
In it, record the Gregory-Aland number of the manuscript you are about to transcribe and the name 
of the book and the number of the first folio of that book. Place your initials next to ‘Transcribed 
by:’ and the date the transcription is begun, and when it is finished. So, the beginning of the Status 
Note of 04_310140_rk would look like: 
 
{Status: 
G-A Number: 1014 
Name of book transcribed: John 
First folio transcribed: 221r 
Base text used: TRns 
 
Transcribed by: RK  
Transcription begun: 02.09.08 
Transcription finished: 11.11.08 
 
 
In the status note there are also four questions that require yes or no answers that should be 
completed: 
 
Does this manuscript contain (delete and complete as appropriate): 
 Lectionary annotations - Yes   No 
 Initials and other enlarged letters - Yes   No 
 Diples (>) - No   Yes: on the following folios 00r, 00v ... 
            Obeloi (†) -   No   Yes: on the following folios 00r, 00v ... 
 
 
There is also a space for other remarks that you might wish to make about the text as a whole, for 
example, ‘Very heavily abbreviated’ or ‘Iota adscript used’: 
 
Other remarks:         
                                    } 
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4. Recording Folios, Pages, Columns and Lines 
 
 
Two, independent transcriptions are made of every manuscript. One transcription must include page 
layout information; it is not necessary for both transcriptions to contain this information. If you 
have been asked to produce a transcription with page layout information included, you will need to 
tag folio or page numbers, column numbers and every line. Instructions for doing this follow. If you 
have not been asked to record page layout information in your transcription, skip the next section 
and go to 5. Alterations to the Base Text in the Transcription. 
 
All of the tags in this section can be typed, or copied and pasted from the Items to Copy and Paste 
document. None of them require the Greek Polytonic keyboard. 
 

4.1 Folios, Pages, Columns and Lines 
 
Folio At the beginning of every new folio,15 the folio number must be recorded and 

whether it is recto (right-hand side of an opening) or verso (left-hand side of an 
opening). They are marked as follows: |F 000r| (|F, space, Arabic numeral, r|) for a 
recto folio and |F 000v| (|F, space, Arabic numeral, v|) for a verso folio, replacing the 
‘000’ with the folio number as it is recorded on the manuscript (usually recorded in 
the top right-hand corner on the recto side). Note: If a folio number has one or two 
numerals, it is recorded as, for example, |F 3r| or |F 45v|, i.e., there should be no 
numeral 0 before the number.   

 
Page  If the folio number is missing, or if every page of a manuscript is numbered, the 

modern page number, tagged as |P 000| (|P, space, Arabic numeral|), should be used. 
As with numbering folios, if a page has one or two numerals, it is recorded as, for 
example, |P 5| or |P 17|. 

 
Column Columns tags are added to the transcription if there are two or more columns to a 

page. They are tagged as follows: |C 0|, with a number replacing the ‘0’ (|C, space, 
Arabic numeral|). The folio number precedes only the first column tag; it is not 
repeated before subsequent columns.  

 
Line All new lines are preceded by the following tag: |L|. It is visually helpful to add a 

carriage return at the end of the preceding line and before the line break tag.  
 
Folio and column numbers are placed before the first line of text, before the first block markers. 
There is no line break tag preceding a folio or column number, but one must precede the first block 
marker and beginning of the text: 
 

                                                             
15 See ‘Folio’ in Glossary. 
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Example: Folio and Column Number at the Beginning of Transcription 

                                                              |F 200r| 
                                                              |C 1| 
                                                              |L|<B 02> <K 1> <V 1> αρχη του ευανγελλιου … 

 
The block markers should be separated by spaces but there should never be a space between a line 
break tag and a block marker. 
 
Throughout the rest of the text, the folio and column numbers are placed on separate lines, again, 
without line break tags: 
 

Example: Folio and Column Number in the Middle of Transcription 

                                                                           |L|ο βαπτισμα … 
                                                                           |F 202r| 
                                                                           |C 1| 
                                                                           |L|ερημω και … 
                                                                                    |L|σων βαπτισμα … 
                                                                                    |L|τανοιας … 
                                                                                    |C 2| 
                                                                                    |L|υποδηματων … 

 
New lines in the manuscript are indicated in the transcription with the tag |L| at the beginning of 
every new line. There should never be a space between the line break tag and the word that comes 
after it. 
 
Each line that ends in a complete word should end with a space before hitting ‘carriage return’ to 
start a new line. In practice, this means placing the cursor after a space between words, immediately 
to the left of the word that is to start the new line.  
 

4.2 Text Beginning Part Way Down a Page 
 
Very occasionally, a text does not begin at the beginning of a page, in other words, not on line 1, 
column 1. In such instances, the rule for tagging the first folio and column is modified: 
 

• If the text has only one column, the folio number is placed in braces: { }. See example 2 
below. 

• If the text has multiple columns, either, 
 The folio tag is recorded after the column tag, if the text begins on the first line of a 

column (see example 3) or, 
 If the text begins part way down a column, both the folio number and the column 

number are placed in braces (see example 4).16 
 
                                                             
16 The reason for this complicated structure is that the same folio number cannot be provided in the transcriptions of two 
texts belonging to the same manuscript (for example, in the transcription of the last page of Mark and in that of the first 
page of Luke). The braces {…} have the effect of ‘hiding’ the second occurrence of the folio number when the 
transcriptions are processed, but still enable us to see them (in this example, the folio number at the beginning of Luke 
would be in braces). If one of the folio numbers is not in braces the result would be an error in the processing of the 
transcriptions. 
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Example 1 Example 2 Example 3 Example 4 

             |F 107v| 
             |C 1 |  

{|F 107v |} |C 3|{|F 107v|} {|F 107v ||C 2|} 

 
Only the first folio number and (if applicable) column number needs to be placed in braces if the 
new text begins part way down a page, not subsequent folio and column numbers. 
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5. Alteration of the Base Text in the Transcription 
 
The following guidelines on altering the base text to create a transcription are intended for all 
transcribers, those who are adding page layout information, and those who are not. Those who are 
not adding page layout information will notice the following symbol in the diagrams: |L|. This 
symbol indicates the beginning of a new line in a manuscript and can simply be ignored if you are 
not adding page layout information. 
 
The goal of the transcription is to reproduce the text of the manuscript as completely as possible. 
Therefore all orthographic, itacistic, grammatical and lexical variations are recorded. 
 
The base text remains unchanged in those places where the manuscript being transcribed agrees 
with it. When the manuscript differs, the base text is changed to match it. So if, for example, the 
text you are transcribing reads βηθανια and the base text reads βηθαβαρα in John 1.28, delete the 
βαρ of βηθαβαρα and replace it with νι.  
 

5.1 Inscriptions and Subscriptions 
 
An inscription is the title of a book, recorded at the beginning of the copy of the text. A subscription 
is a statement added at the end of a copy of the text, indicating what it is. It is sometimes followed 
immediately by a statement of the next book. Both inscriptions and subscriptions are to be recorded 
in the transcription. Abbreviations are written out in full, with added letters recorded in parentheses, 
for example, ιω(αννην).17  
 
A line break tag should precede both inscriptions and subscriptions. For inscriptions the block 
marker <K 0><V 0>, in other words, chapter 0, verse 0, is used. A subscription is indicated by a 
chapter and verse number following the number of the last chapter in the document, and verse 0. 
For example, a subscription in the Gospel of John, with the last chapter of John being chapter 21, 
would be tagged as <K 22><V 0>. 
 
 

Example: Tagging Inscriptions and Subscriptions 
|F 283r| 
|L|<04> <K 0> <V 0> ευαγγελιον κατα ιωαννην 
|L|<K 1> <V 1> εν αρχη ην ο λογος …                                       
  

|L|… γραφομενα βιβλια αμην 
|L|<K 22> <V 0> το κατα ιωαννην αγιον ευαγγελιον 

 
 
 

5.2 Word Division 
 
If you are recording page layout information in your transcription, you will be including the tag |L| 
at the beginning of every new line. If you are not recording page layout information, it can be 
                                                             
17 See 5.7.5 Nomina Sacra, Ligatures and Abbreviations. 
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helpful to add a carriage return after the last word of a line of text in the manuscript. This helps you 
see where you are in your transcription. Whether or not you are including the |L| tag, if a word runs 
over two lines, the word is split by adding an equals sign ‘=’ at the point where the word breaks. Do 
not introduce a space in your transcription at the point where the word breaks. 
 

Example: Word Broken over Two Lines 
With line break tags:  
                                        

 |L|…εορα= 
 |L|καμεν … 

Without line break tags:  
                                               

…εορα= 
καμεν … 

 
It is important to remember that, during the process of transcribing, you will be using two keyboard 
layouts, English and Greek Polytonic. You can add the equals sign ‘=’ from both keyboards, but 
while using the English keyboard the stroke is simply =, on the Greek Polytonic keyboard it is Alt + 
=. If you are in Greek Polytonic mode, remember to key Alt + = to indicate a word division, 
otherwise you will find that you have keyed something like …εορα῍ instead of …εορα=. Conversely, 
if you are in English mode, and you inadvertently key Alt + =, you will find that you have keyed 
something like …εορα≠ .  
 
If the beginning of a word is lacunose18 or illegible19 at the end of one line but the rest of it is extant 
at the beginning of the next line, the ‘=’ is positioned after the relevant tag: 
 

Example: Partially Lacunose Word Broken over Two Lines 
                                                                          |L|…[º]εορα[\º]= 
                                                                          |L|καμεν … 
 
If a line break divides a corrected word – a word in ‘app tags’20 – the |L| and the = are recorded only 
within the tag of the first hand reading ([*]…[\*]). The correction ([C]…[\C]) then follows the 
reading of the first hand without including the |L| or the =: 
 

Example: Corrected Word Broken over Two Lines 
                                                              |L|…[app][*]εορα= 
                                                              |L|καμεν[\*][C]εωρακαμεν[\C][\app] … 
 

5.3 Omissions and Lacunae 
 
5.3.1 Omissions 
 
Omissions can be defined as places where the text is present in the base text but not in the text of 
the manuscript you are transcribing. If the omission consists of less than one verse, the omitted 
section is simply deleted from the transcription.21 
 

                                                             
18 For lacunae see 5.3 Omissions and Lacunae and ‘Lacuna’ in Glossary. 
19 For instructions on dealing with illegible text, see 5.4.2 Illegible Text. 
20 ‘App tags’ are explained at 5.5.1 App Tags and First Hand Reading Tags. 
21 The only time that an omission of less than one verse is indicated in a transcription is when the omission is part of a 
correction and it becomes necessary to record it in order to clearly present the reading of the correction. See 5.5.3 
Correction of Omissions or Deletion by Correctors. 
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In the case of an omission of an entire verse, the text of the entire verse is deleted but the block 
marker is retained and a reference to the omission is added in curly brackets in the following way: 
{om}, for example, <V 17> {om}. If a block of verses is omitted, delete the omitted text but retain 
each verse block marker followed by a reference to its omission, without adding new line breaks: 
 

Example: A series of Continuous Omissions 
|L|<K 2> <V 1> {om} <V 2> {om} <V3> {om} 

 
5.3.2 Lacunae 
 
A lacuna is a loss of text caused by the material on which a manuscript was written having been 
lost. Lacunae can be divided into three types, depending on their size: 
 

• Verse lacunae consist of at least one entire verse. 
• Word lacunae consist of at least one entire word but less than one verse. 
• Partial word lacunae consist of at least one letter but less than one word. 

 
Verse Lacunae 
 
If a complete verse or more than one verse is missing from the text because of missing material, the 
block marker and the text of the relevant verse/s are deleted. This is in contrast to omissions, where 
the text is deleted but the block marker is retained. The extent of the lacuna is recorded in braces, 
for example, {2.12-8.7} meaning that chapter 2 verse 12 to chapter 8 verse 7 is lacunose. If an 
entire chapter is lacunose, the chapter block marker, the verse block markers and the complete text 
of the relevant chapter are deleted. If the lacuna extends into a new chapter or spans several 
chapters, the relevant chapter block markers must be retained and added at the beginning of the text 
immediately following the lacuna. 
 

Example: Recording the Extent of a Lacuna in Braces 
                                                                 |L|< 11> εγειρε σοι λεγω … 
                                                                 |L| … εις τον οικον σου {2.12-8.7} 
                                                                 |L|<K 8> <V 8> και εφαγον παντεσ … 
 
Word Lacunae and Partial Word Lacunae 
 
Word lacunae and partial word lacunae are indicated by the ‘lacuna’ tag: [º]…[\º]. 
 
If at least one letter of a line is extant, the missing text should, if possible, be reconstructed and 
recorded within lacuna tags: 
 

Example: A Reconstructed Line with One Extant Letter 
|L|κ[º]αι το φωσ εν τη σκοτια[\º] 

 
If text is missing from both the beginning and the end of a line, reconstruct and record within lacuna 
tags the material that is likely to be missing: 
 
 



 23 

Example: A Reconstructed Line with Lacunose Letters at Both Ends 
|L|[º]και εθεασαμεν[\º] την δ[º]οξαν[\º] 

 
There should never be a space between the opening tag and the first letter within the tags, or the last 
letter within the tags and the closing tag.  
 
If individual letters of a word are missing and cannot be inferred with certainty, the estimated 
number of missing letters that could fit into the lacuna should be recorded as a numeral in the 
lacuna tag: 
 

Example: Estimating the Number of Missing Letters 
|L|<V 23> παρα[º]7-8[\º] 

 
Word lacunae that comprise at least one entire line are indicated by the following lacuna entity: 
&lac; (ampersand, lac, semicolon). If several entire lines are missing, the transcription should also 
reconstruct the number of missing lines between the extant lines, by repeating the line break tag and 
the lacuna entity: 
 

Example: Lacunae of Several Lines 
                                                                     |L|[º]ην δε σ[\º]ιμων … 
                                                                     |L|&lac; 
                                                                     |L|&lac; 
                                                                     |L|&lac; 
                                                                     |L|[º]λεγ[\º]ει εισ … 
 

5.3.3 Closing Lacuna Tags 
 
If a lacuna continues onto the next line, it must be closed at the end of the complete lacuna, not at 
the end of each line: 
 

Example: Lacunae of Several Lines 
                                                                   |L|…καθωσ εμε α[º]πεστ= 
                                                                   |L|ειλασ[\º] εισ τον … 
 
If the lacuna spans the end of one verse and the beginning of the next, the tag must be closed at the 
end of the verse, that is, before the block marker of the next verse, and reopened at the beginning of 
the next verse: 
 

Example: Lacuna Spanning Two Verses 
                                                           |L|… των ιου[º]δαιων ου= 
                                                           |L|τοσ[\º] <V 39> [º]εισ δε[\º] των … 
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5.4 Difficult to Read Text 
 
Sometimes it is very difficult to decide what a scribe actually wrote. Parts of letters may be 
lacunose, the script itself may be illegible, the image you are using may be very poor, or there may 
be ink blots and other marks obscuring the text. There are two ways that you can flag such 
difficulty: 
 
5.4.1 Uncertain Letters 
 
Uncertain letters, in other words, letters that are so damaged that several interpretations could be 
possible, should have a dot placed beneath them. This can be created by inserting Unicode character 
0323, Combining Dot Below, immediately after the letter. A full list of letters with dots beneath is 
available for copy and paste in the Items for Copy and Paste document. 
 
If a letter is partially extant, yet could only be part of one letter (e.g. half of an omega) do not place 
a dot beneath it. 
 
For uncertain letters in a nomen sacrum, see 5.7.4 Nomina Sacra, Ligatures and Abbreviations. 
 
5.4.2 Illegible Text 
 
[ill]…[\ill] If it is clear that there is text present, but it is now completely illegible (as distinct 

from lacunose), tag the ‘text’ as illegible. As with lacuna, missing text should, if 
possible, be reconstructed and supplied within the ‘illegible’ tags: 

 
Example: Reconstructed Illegible Text 

|L|κ[ill]αι το φωσ εν τη σκοτια[\ill] 
 
If it is not possible to reconstruct the text with any degree of certainty, for example, if the base text 
contains 15 characters and the area of illegible text is not large enough to contain 15 characters, put 
the approximate number of illegible characters in ‘illegible’ tags: 
 

Example: Estimating the Number of Illegible Letters 
|L|απεκριθη [ill]4-6[\ill] εγω βαπτιζω 

 

5.5 Corrections, Alternative and Commentary Readings 
 
Corrections, alternative and commentary readings must all be recorded in the transcriptions within 
square bracketed tags. 
 
5.5.1 App Tags and First Hand Reading Tags 
 
[app]…[\app]: All tags that are used to record corrections, alternative and commentary readings are 

embedded within so-called ‘app tags’. They define the extent of any given correction 
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and act as necessary ‘containers’ of all the different variables within any given 
correction. 

 
[*]…[\*]:  The first item recorded after the opening app tag is the first hand reading, which is 

surrounded by the following tags: [*]…[\*]. In the case of corrections, this tag is used 
to record the original, first hand reading. In the case of commentary readings, it is 
used to record the text that is being commented on. In the case of alternative 
readings, it is used to record the text that an alternative reading is being presented 
against. 

 

5.5.2 Corrector Tags 
 
[C]…[\C]:  A change to the original text made by a corrector is then added within ‘corrector 

tags’. A correction is a change to the original text, made by a corrector or the scribe 
himself, indicated by erasure; bracketing; crossing out; dots above letters; or an 
indication that material is to be transposed (usually by marking the text with small 
numbers, letters or other signs). The replacement text may be written on the line, 
between lines, or in a margin. Sometimes letters or words of the continuous text are 
not marked in any way (e.g. they are not crossed out to indicate that they have been 
corrected) but an alternative has been written interlinearly, for example, παιδον, 
written interlinearly above τεκνον. Such alternatives should also be treated as 
corrections. 

 
The most basic corrector tag is [C]…[\C]: 
 

Example of Tagging of a Basic Correction 
[app][*]κληρους[\*][C]κληρον[\C][\app] 

 
It is occasionally possible to discern a little more information about a correction. Sometimes, it is 
clear that a correction has been made by the first hand in the process of writing; a first hand 
correction is tagged as [C*]…[\C*]. The most obvious example is when it is clear that the scribe 
began writing one word, realised his error part way through so stopped, and wrote another word 
instead.22 The script must clearly be of the same hand, written as part of the main body of text. It 
cannot be interlinear or marginal. If you cannot decide with any degree of certainty that the 
correction is made by the first hand, tag it as [C]…[\C]. 
 
Sometimes it is also possible to distinguish between more than one corrector in any given 
transcription. In such instances, they can be identified with the tags [C1]…[\C1], [C2]…[\C2] or 
[C3]…[\C3]. Note that it is far more likely to be able to distinguish between different hands (and 
inks) from a manuscript itself or a digital image of one, rather than from a microfilm or a digital 
scan of a microfilm. 
 
There should be no spaces between the different parts of the tags and the words. 
 
The smallest unit that can be placed within corrector tags is one word, whether that word is a single 
letter, such as the article η or a much longer word. Do not tag parts of words. For example, if the 
word αυτον has been corrected to αυτου, tag the whole word, not just the nu and upsilon. 
                                                             
22 See the first example in the box below, ‘Some Further Examples of Corrections’. 
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In a correction, if the letters of the first hand are illegible, the ‘illegible’ tag should be placed within 
the ‘first hand’ tags: 
 

Examples of Tagging an Illegible First Hand 

                                           [app][*][ill]εαυτων χωραν[\ill][\*][C]χωραν αυτων[\C][\app]  

                                           [app][*][ill]15-18[\ill][\*][C]το λινον το σχιστον[\C][\app] 
 
 

Some Further Examples of Corrections 

ποιηται λογ νομου ποιηται [app][*]λογ[\*][C*]νομου[\C*][\app] 
Correction by the first hand made in the process of writing. 

    ω 
πορευσο̇μεθα 

[app][*]πορευσομεθα[\*][C]πορευσωμεθα[\C][\app] 
The dot above the omicron means that the corrector wishes to delete it 
and replace it with the omega written above it. 

                             ι 
βασλειασ 

[app][*]βασλειας[\*][C]βασιλειας[\C][\app] 
In this case, the corrector is clearly correcting a spelling mistake. 

                              ο 
οι ανθρωποι ηλθεν 

[app][*]ηλθεν[\*][C]ηλθον[\C][\app] 
The plural subject requires the 3rd person plural of the verb; the 
corrector has spotted the mistake and rectified it by writing the omicron 
above the epsilon. 

 

|L|δε αυτου συναιριν 
|L|προσηνεχθη [app][*]εις 
|L|αυτου[\*][C]αυτου εις[\C][\app] οφιλετης 
|L|[app][*]πολλων[\*][C]μυριων[\C][\app] ταλλατω 
The signs IΙ, I and III indicate a correction of word order. 

 
5.5.3 Correction of Omissions and Deletions by Correctors 
 
If a) an omission of the first hand ([*]) has been corrected, or b) a deletion of a word, phrase or 
verse has been made by a corrector, the omission/deletion is indicated by &om; within the 
appropriate tags. 
 

Example: Omission or Deletion 
a) [app][*]&om;[\*][C]ουτωσ[\C][\app] 

b) [app][*]ουτωσ[\*][C]&om;[\C][\app] 

 

5.5.4 Closing Corrector Tags 
 
If a correction spans two or more lines, the corrector tag must be closed at the end of the entire 
correction and not at the end of each line of the correction. Note that ‘=’ and |L|, marking word 
breaks and line breaks, are only recorded within the first hand tags ([*]…[\*]) and not in the 
subsequent corrector tags ([C]…[\C]). 
 
 



 27 

Examples of the Tagging of a Correction Spanning More than One Line 
a) 

 
|L|σισ ουτωσ ην [app][*]μνησ= 
|L|στευθισησ[\*][C]μνηστευθεισησ[\C][\app] 

b) 
 

|L|χνοσ [app][*]υπο τον 
|L|μοδιον τεθηναι[\*][C]ινα υπο τον μοδιον τεθη[\C][\app] η 

 
If the correction spans the end of one verse and the beginning of the next, the tag must be closed at 
the end of the verse, that is, before the block marker, and reopened at the beginning of the next 
verse: 
 

Example of the Tagging of a Correction Spanning More than One Verse 
            |L| … [app][*]ιου= 
            |L|δαιασ[\*][C]γαλιλαιασ[\C][\app] <V 29> [app][*]και ευθυσ[\*][C]ευθυσ πανταχη και[\C][\app] 

 
Similarly, if an omission spans the end of one verse and the beginning of the next, and text has been 
added by a corrector, the tag must be closed at the end of the verse and reopened at the beginning of 
the next: 
 

Example of the Tagging of a Corrected Omission Spanning More than One Verse 
            |L|μαθητες [app][*]&om;[\*][C]αυτου[\C][\app] <V 11> [app][*]&om;[\*][C]και ιδοντες[\C][\app]  

 
5.5.5 Commentary Readings 
 
[K]…[\K] A commentary reading occurs mainly in commentary manuscripts,23 that is, 

manuscripts that contain biblical text and commentary on that text. It indicates a 
reading in the commentary that differs from the biblical text itself. It is not necessary 
to read the entire commentary to find relevant text, but only commentary text that is 
clearly marked as biblical, for example, rubricated text (text written in red instead of 
black or brown ink). In such instances the biblical text is recorded first, in [*]…[\*] 
tags, followed by the rubricated, or otherwise highlighted, biblical text embedded in 
the commentary text, tagged in ‘commentary’ tags, [K]…[\K].  

 
[K]…[\K] tags should also surround additional notes (glosses and scholia) found in 
continuous text manuscripts. Glosses are short explanations of particular texts added 
to the manuscript, usually in the margin. The difference is not exact, but in general 
scholia (scholarly comment) offer something more like a commentary on a particular 
text.  
 

Example of Tagging a Word Commented on in the Margin 
[app][*]μολοχ[\*][K]ειδωλον μωαβιτων[\K][\app] 

 

                                                             
23 See ‘Commentary Manuscripts’ in the Glossary. 
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5.5.6 Alternative Readings 
 
[A]…[\A] An alternative reading usually only occurs in minuscules (though there are a few in 

some majuscules). It is a reading that is different from the text, but is shown to be an 
alternative rather than a correction by the addition of one of the following notes: 

 
• εν αλλοισ (αντιγραφοισ) 
• εν αλλω (αντιγραφω) 
•    γραφεται or γεγρ(απται) 

 
An alternative reading should be recorded with the tag [A]…[\A] after the first hand 
reading tags, for example, [app][*]τεκνον[\*][A]παιδον[\A][\app]. 
 

5.6 Personal Comments on the Text 
 
If there is anything of particular interest, or text that you find particularly difficult to read, you may 
add a personal note commenting on the fact, after the text in question. For example, if you have 
placed dots beneath some letters or word/s because the text has been partially obscured by an ink 
blot, you may want to note that fact. In order that the programme doesn’t treat such notes as 
readings, place them in braces, for example, εισηγ̣α̣γ̣εν {ink blot obscures uncertain letters}. 
 
Important: Braces cannot be placed between block markers, for example, between <K 4> and <V 1> 
in your transcription. Tags cannot be placed within braces. 
 
Comments that pertain to the complete text should be added to the Status Note, under ‘Other 
remarks’ (see 3.3 Status Note). 
 

5.7 Miscellaneous Items 
 
5.7.1 Symbols that are not to be Transcribed 
 
Do not record the following items and symbols24 in your transcription: 
 

• Catch words  
• Colophons 
• Custoden 
• Binding Marks 
• Ekphonetic Notation 
• Eusebian Apparatus 
• Euthalian Apparatus 
• Hypodiaireses  
• Hypotheses 

                                                             
24 All of these items are defined in the Glossary. 
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• Kephalaia  
• Spatium  
• Stichoi 
• Titloi  

 
Do not record the following items and symbols in your transcription, but record their presence in 
the Status Note (see 3.3 Status Note): 
 

• Diples25 
• Initials and other enlarged letters 
• Liturgical signs (for example, the lectionary notes αρχη and τελοσ)26 
• Obeloi27  

 

5.7.2 Accents and Breathing Marks 
 
Accents and breathing marks are generally not to be transcribed. The only times that accents or 
breathing marks are to be recorded are when the accenting/breathing alters the meaning of the text. 
In such instances, three alternative readings are presented in the base text. The first option is the 
word without an accent or breathing mark. The second and third options are the two alternative 
readings with accents/breathing marks, recorded in braces, for example, μενει {µένει μενεῖ} or 
αυτου {αὐτου αὑτου}. Decide which of the three alternatives is the correct one and delete the 
alternatives and the braces. 
 

5.7.3 Punctuation Marks 
 
Punctuation marks are not to be transcribed in minuscule manuscripts. 
 

5.7.4 Iota Adscript/Subscript 
 
Iota adscript: to be included.  
Iota subscript: not to be included. 
 
The reason for this is to encourage transcribers to record everything they see in the continuous run 
of text, which should avoid the occasional mistaken omission of an iota that is not, in fact, an iota 
subscript. 
 
5.7.5 Nomina Sacra, Abbreviations and Ligatures 
 
Nomina Sacra28  
 
Nomina sacra are abbreviated sacred names. They are recorded by copying the text of the 
manuscript as it appears and always placing the overline above the second letter, for example, ις̅ for 
ιησσυς and πν̅̅α for πνευμα. The overline is created by inserting Unicode character 0305, 
Combining Overline, directly after the second letter. A list of the most common nomina sacra can 
                                                             
25 See ‘Diple’ in Glossary. 
26 See ‘Lectionary Notes’ in Glossary. 
27 See ‘Obelos’ in Glossary. 
28 See ‘Nomina Sacra’ in Glossary. 
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be found in the Appendix and they are also available for copying and pasting from the Items for 
Copy and Paste document. It is important to note that they can be declined and that their form can 
change accordingly.  
 
In an abbreviated nomen sacrum that begins with a preposition, the overline is still placed above the 
second letter, so, for example, επ̅ουνια not επου̅νια. 
 
Note: In some manuscripts, sacred names and sometimes other names, such as πετρος, are written 
out in full, with an overline above any of the letters, such as πετρο̅ς or ιωαν̅νης. The rule to follow 
is: if the name is written in full, add the overline in the position it appears. Sometimes a nomen 
sacrum is written without an overline, e.g.  υν or θυ. The rule to follow in such instances is: omit 
the overline. So, in both instances, record what is present. Also, in both instances, add the Latin 
note sic next to the word in braces, as {sic}. 
 
If only the overline is preserved, and the letter beneath it is uncertain, the letter should be recorded 
with a dot beneath it. First type the letter, then the dot below, then the overline, in other words, 
letter, Unicode 0323, Unicode 0305. A list of letters with underdots and overlines is available for 
copy and paste in the Items for Copy and Paste document. 
 
Abbreviations and Ligatures  
 
Abbreviations and ligatures should be written out in full.  
 
Abbreviated words have some clearly identifiable letters or symbols, such as the superline for final 
nu, for example, εστι̅ for εστιν. Abbreviations can also be indicated by raised, small, letters. If an 
abbreviated word contains a symbol replacing a letter, or contains small letters, record the symbol 
and/or small letters as ordinary letters. For example, the final nu overline is simply transcribed as ν. 
 
At times, usually at the end of a line, you will see a shortening stroke that replaces the last few 
letters of a word. Such a stroke is not a symbol for particular letters, but the letters it represents are 
quite clear from the context. In such instances, record the missing letters as normal. 
 
Sometimes some letters have not been written, but their omission is fairly common shorthand. For 
example, ουδ is sometimes written as a shorthand way of representing ουδεις and  προ is written as 
a shorthand way of representing προς. These and other known shorthand expressions can be found 
in several sources that deal with Greek abbreviations and ligatures.29 Such words should be 
recorded in full so, taking these examples, ουδ should be recorded as ουδεις and  προ should be 
recorded as προς. 
 
If a word is missing some letters, and you are not sure if it is a known abbreviation, the missing 
letters should be enclosed by parentheses (…). 
 

Example: Abbreviations 
εστι̅  should be recorded as εστιν  
προ  should be recorded as προς  

ιωανν should be recorded as ιωανν(ου)  

                                                             
29 These sources include pages from C. Faulmann, Das Buch der Schrift, V. Gardthausen, Griechische Palaeographie 
and T.W Allen, Abbreviations in Greek Manuscripts. You can request pdfs of this material by contacting Bruce or 
Rachel. 
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Example: Abbreviations 
του αγ αποστολ  should be recorded as του αγ(ιου) αποστολ(ου)  

 
Ligatures are formed when two or more letters are merged into one single form,30 such as the 
ending –ται. Gardthausen provides some differentiation of ligatures:31 

(1) Primary ligatures: two letters are written over each other so that they form one symbol, 
for example,  
(2) Secondary ligatures: two letters are not just externally joined, but one part of the first 
letter is simultaneously also part of the second letter, for example,  
(3) Tertiary ligatures: three or more letters are joined together into one inseparable unity, for 
example,  
 

Words that contain ligatures are written out in full. 
 

Example: Ligatures 
ᶄ = και 

 
Note: If you are unsure about how to record an abbreviation or ligature, put the relevant letters in 
parentheses. It is worth remembering, however, that most of the time parentheses are not needed. 
 

                                                             
30 See ‘Ligature’ in Glossary. 
31 A pdf of the relevant pages of  V. Gardthausen, Griechische Palaeographie is available by emailing Bruce or Rachel. 
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6. Supplements 
 
 
A supplement is an addition to a manuscript of at least one entire leaf or (very rarely) part of a leaf, 
replacing original material. An important indicator of a supplement is a change of handwriting often 
accompanied by a change in the number of lines or columns. A supplement can occur anywhere, 
even at the very beginning of a manuscript.  
 
If a document, for example 200040, contains supplementary material, the supplementary text should 
be transcribed in a separate file. A note in braces should be inserted in the main text file at the point 
where the supplement begins, saying {supplement here}. 
 
The supplementary text, transcribed in a separate file, is given the suffix 1. So, for example, a 
transcription file of supplementary text in 04_200040_rk is given the file name 04_200041_rk. A 
second supplement would be given the suffix 2 (e.g. 04_200042_rk) and so on, though more than 
one supplement is rare. 
  
If the handwriting changes in the middle of a regular page this information should be recorded in 
braces as {change of hand}. The same note should be also added to the status note. It is not a 
supplement. 
 
 



 33 

 

7. Ending the Transcription 
 
 
Be sure to save your transcription at regular intervals throughout your work and when you have 
finished the transcription by clicking ‘Save’ in the ‘File’ menu.  
 
To leave Word go to Word>Quit Word.  
 
To leave jEdit go to File>Exit.  
 
To leave BBEdit go to BBEdit>Quit BBEdit. 
 
Also, it is important to regularly back up your transcriptions in a place other than on your local hard 
drive. 
 
IGNTP transcribers should send their completed transcription to Bruce Morrill (US) or Rachel 
Kevern (UK) (see 8.6 Contacts for email addresses). 
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8. Appendix 
 
 
This appendix contains information that you may find useful in the process of transcribing a text. 
 

8.1 General Keystroke Table for Gentium using the Greek Polytonic Keyboard 
 
Lower case 
 

§ 1 2 3 4 5 6 7 8 9 0 ῏ ῍ 
; ς ε ρ τ υ θ ι ο π ῀ `  
α σ δ φ γ η ξ κ λ ´ ᾽ \  
` ζ χ ψ ω β ν μ , . ῎   

 
Note: The Greek Polytonic keyboard uses as different transliteration scheme from the one that you 
may be used to if you have been using fonts such as Symbol Greek, or Symbol. The characters to 
watch out for have been highlighted in yellow. 
 
Upper case (+ Shift) 
 

± ! @ # $ % ^ & * ( ) ῟ ῝ 
: ΅ Ε Ρ Τ Υ Θ Ι Ο Π ι `  
Α Σ Δ Φ Γ Η Ξ Κ Λ ¨ ῾ |  
~ Ζ Χ Ψ Ω Β Ν Μ < > ῞   

 
Lower case + Alt 
 

§ ¹ ² ³ £ § ¶ ϗ • · ° - = 
ϙ ϝ € ϱ ™ ¥ ϑ ι ϛ ϖ [ ]  
… ϲ ÷ ϕ © ¬ ϳ ϰ ˘ ; ‘ ¦  
; ϟ ϸ ϡ ‘ ϐ ’ ϻ « » /   

 
Upper case (+ Shift) + Alt 
 

±  ½ ϶ ¢       _ + 
Ϙ Ϝ ϵ  † ϒ ϴ  Ϛ ≈ { }  
 Ϲ   ®    ¯ : “   
· Ϟ Ϸ Ϡ “  ” Ϻ ≤ ≥ ?   
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8.2 The Most Common Forms of Nomina Sacra 
 

αν̅ος ανθρωπος ου̅νος ουρανος 
δα̅δ δαυιδ πη̅ρ πατηρ 
θς̅ θεος πν̅α πνευμα 
ιλ̅ημ ιερουσαλημ πν̅ικος πνευματικος 
ις̅ ιησους στ̅ρος σταυρος 
ιη̅λ ισραηλ ση̅ρ σωτηρ 
ιω ̅ ιωαννης σρ̅ια σωτηρια 
κς̅ κυριος υς̅ υιος 
μη̅ρ μητηρ χς̅ χριστος 

 
It is important to note that the nomina sacra can be declined and change their form accordingly, so 
θεον becomes θν̅ and θεου becomes θυ̅ etc. 
 
The overline is Unicode 0305: Combining Overline. It is inserted after the letter that it goes above. 
A list of the most common forms of nomina sacra are available for copy and paste from the Items 
for Copy and Paste document. 
 

8.3 List of New Testament Book Numbers 
 
  Book NA UBS Number Book NA UBS Number 

Matthew Mt Mt 01 1 Timothy 1T 1Tm 15 
Mark Mc Mk 02 2 Timothy 2T 2Tm 16 
Luke L Lk 03 Titus Tt Tt 17 
John J Jn 04 Philemon Phm Phm 18 
Acts Act Ac 05 Hebrews H He 19 

Romans R Ro 06 James Jc Jas 20 
1 Corinthians 1K 1Cor 07 1 Peter 1P 1Pe 21 
2 Corinthians 2K 2Cor 08 2 Peter 2P 2Pe 22 

Galatians G Ga 09 1 John 1J 1Jn 23 
Ephesians E Eph 10 2 John 2J 2Jn 24 
Philippians Ph Php 11 3 John 3J 3Jn 25 
Colossians Kol Col 12 Jude Jd Jd 26 

1 Thessalonians 1Th 1Th 13 Revelation Ap Re 27 
2 Thessalonians 2Th 2 Th 14     
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8.4 Greek Numbers 
 

α= 1 ι= 10 ρ= 100 _α = 1000  
β= 2 κ= 20 σ= 200 _β = 2000 
γ= 3 λ= 30 τ= 300 _γ = 3000 
δ= 4 μ= 40 υ= 400  (y) etc. 
ε= 5 ν= 50 φ= 500  

ϛ= 6  (o + alt) ξ= 60  (j) χ = 600 ϛ = stigma  
ζ = 7 ο= 70 ψ = 700  (c) ϙ = koppa 
η = 8 π= 80 ω = 800  (v) ϡ= sampi  

θ= 9  (u) ϙ= 90  (q + alt)  ϡ = 900  (c + alt)  

 
Examples of Numbers 

ξη   = 68 
σοε   = 275 

 

8.5 Itacism (similar sound) and Isochronie (same sound) 
 
Itacism (similar sound): 
The following groups have a similar sound: 

• ι ει οι η υ 
• ε αι 
• β υ  (δαυιδ - δαβιδ) 
 

Isochronie (same sound): 
 
The following group has the same sound:   

• ω ο 
 

8.6 Contacts 
 
Bruce Morrill at bruce@math.ksu.edu (US) 
Rachel Kevern at r.kevern@bham.ac.uk (UK) 
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9. Glossary 
 
 
The terms marked by an asterisk are from D.C. Parker, An Introduction to the New Testament 
Manuscripts and their Texts (Cambridge University Press, 2008). 
 
*Apparatus A critical apparatus (often given its Latin name apparatus criticus) refers to the 

section usually at the bottom of the page (or after a block of text – in either case 
below the text) which contains the variant readings and statements of manuscripts 
supporting each one. The word apparatus is good English, with a plural apparatuses, 
but it is also good Latin. A Latin noun of this class has a plural form which is spelt 
the same, but with a long instead of a short u, so one will find the plural apparatus or 
apparatus critici. Like other Latin nouns of this class, it tended to become confused 
with another class also ending in -us, but with a plural in -i. So one may occasionally 
find the plural form apparati critici. Whether one chooses English or Latin, the 
correct plural form is unambiguous so long as the adjective is supplied. 

 
Asterisk  A text-critical symbol found in some ancient manuscripts, the meaning of which is 

not completely understood. It is only transcribed in selected passages.  
 
Catch Words Along with custoden (see below), catch words are used to indicate the order of 

gatherings. The first word of the following gathering is repeated at the end of the 
previous gathering, usually in the bottom margin. This information is not 
transcribed. 

 
*Catena A collection of quotations from early Christian writers linked together to form a 

commentary on a biblical writing. 
 
*Citation A quotation of a passage from the New Testament in an early Christian writer. 
 
*Clavis In the present context, a manual listing all the works of the Church Fathers to have 

been written in a particular language, including brief details and information on the 
available editions. 

 
*Codex A document made by folding sheets of material in half and combining them in one of 

a number of possible ways to make what is recognised as a book today. 
 
*Collation A list of differences between a manuscript and a base text. Sometimes a number of 

separate collations are combined into one. Such a collation is the base of an 
apparatus. 

 
Colophon  A closing formula in which the scribe provides information regarding, for example, 

his or her name, the name of the patron, and/or the circumstances surrounding the 
production of the manuscript (that is, location, date, etc.). This information is not 
transcribed. 

 
Commentary Manuscripts 
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 Manuscripts that contain, in addition to the biblical text, commentary on the text by a 
Church Father (or several Church Fathers, see Catena). The biblical text and 
commentary are distinguishable from one another in the following ways: 

 (1) The biblical text and commentary are written in different colours of ink and 
sometimes in different scripts (majuscule/semi-majuscule/minuscule). 

 (2) The biblical text is marked by diples (see below) in the margins. 
 (3) The beginning of the biblical text is indicated by κει(μενον), while the beginning 

of the commentary is indicated by ερμ(ηνια). 
 
Commentary Diacritical Marks 
 Symbols, letters or numbers that clarify the relationship between a biblical text 

passage and its commentary. 
 
*Continuous-text manuscript 
 This term distinguishes manuscripts which are not lectionaries, that is they contain 

the text or texts in full and in an accepted order. 
 
Custoden Numbers (normally Greek) or symbols that indicate the beginning and/or end of a 

quire. Usually, though not always, found in the lower, outer margin. They are not 
transcribed. 

 
Binding Marks 
 Marks made in the outer margins of the middle leaf of a gathering (quire) to indicate 

the middle of the gathering for the purpose of binding. 
 
Diple (= διπλη̂)̂ Marks like > or >> made in the margin, next to certain text, to indicate 

that it is a quotation from the Old Testament. Occasionally, the biblical book will be 
named. In a commentary manuscript diples can serve as markers of biblical text, 
distinguishing it from commentary text. Diples are not transcribed, but if they are 
present in a manuscript, their presence, and location (folio number), should be noted 
in the Status Note. 

 
Dittography A copying mistake in which a word, a syllable, or a letter that occurs only once in 

the exemplar is written twice in the copy. (Compare Haplography.) 
 

Example: Jn 5.3 

… ετασσε το υδωρ … … ετασσετο το υδωρ … 

 
*Ductus The way in which a particular scribe has written, referring not so much to the shape 

of the letters as to the way the pen is handled and the letters are put together. 
 
Ekphonetic Notation 
 Refers to symbols added to provide guidelines for the liturgical use of a text. These 

symbols, which look like extra accents, are written in a different ink colour to 
distinguish them from the text. They are not transcribed. 

 
Ekthesis The first full line of a new section, projecting into the left margin, sometimes 

accompanied by an enlarged letter.  
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Eusebian Apparatus 
 ‘A system providing a means for users to navigate their way between parallel 

passages in the Gospels.’32 
 It has four elements:  
(1) Every Gospel is divided into numbered paragraphs, the number being written in 
the margin against the beginning of each section.  
(2) A list of ten tables at the beginning of the Gospels that list parallels between the 
Gospels. 
(3) The number of the table containing each paragraph is written underneath every 
section number in the margin of the text. 
(4) A short explanation of how they work, written by Eusebius to one Carpianus (see 
pp.84*-85* of Nestle-Aland). 
 
The individual paragraphs of the Eusebian divisions are known as Ammonian 
sections. 
 
The Eusebian apparatus is not transcribed. 
 

Euthalian Apparatus 
Supposed to have been compiled by one Euthalius. It consists of various 
supplements and textual divisions in Acts, the Pauline and Catholic Epistles. The 
Euthalian apparatus of the Catholic Epistles, for example, contains the following 
elements: 

  (1) προλογος: Prologue 
(2) ανακεφαλαιωσις των αναγνωσεων: Lists of readings (αναγνωσεις), chapters 
(κεφαλαια), Old and New Testament quotations (μαρτυριαι) and stichoi (στιχοι), 
organized by the individual Epistles and for the Catholics all together. 
(3) προγραμμα: Preliminary remarks on the marking of the quotations. 
(4) ανακεφαλαιωσις θειων μαρτυριων των καθολικων: List of the quotations for 
each individual Epistle.  It provides the quoted books of the Old and New 
Testaments in order, as well as the number of the quotations from these books and 
the order in which they appear. 

 

Example 
εν τη επιστολη ιακωβου 
μαρτυριαι τεσσαρες 

In the Epistle of James there are four quotations 
(Testimonia).  

γενεσεως α, γ              
 

From Genesis: one, namely the third [quote of the 
Epistle of James].  

εξοδου α, β  From Exodus: one, namely the second.  

λευιτικου α, α  From Leviticus: one, namely the first.  

παροιμιων α, δ  From Proverbs: one, namely the fourth. 
 
 

(5) [Before each Epistle] υποθεσισ: Table of contents. 
(6) [Before each Epistle] (εκθεσις) κεφαλαιων: List of the chapter headings.  

                                                             
32 10.3.1 of Parker’s Introduction. 
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(7) [At the end of the Catholic Epistles] Stichometric data as well as the epilogue: 
αντεβληθη δε των πραξεων και καθολικων επιστολων το βιβλιον προσ τα ακριβη 
αντιγραφα της εν καισαρεια βιβλιοθηκης ευσεβιου του παμφιλου. 
 
The Euthalian apparatus is not transcribed. 

 
*Family of manuscripts 
 At least two, but generally more manuscripts which may be shown to be related to 

each other and derived from a common archetype, it being possible to illustrate this 
relationship by means of a stemma. 

 
*Folio The name for one side of a leaf. The two sides are called the recto and the verso. 

These terms are used in two ways:  
(1) In a parchment or paper manuscript, the right-hand page is called the recto, and 
so is often indicated with the numeral followed by r. The left-hand page is the verso, 
and thus called v. The possible ways of numbering leaf 50 of a manuscript are 

 recto 50r 50a 50 
 verso 50v 50b 50v or 50b 
 Abbreviated as fol., F, f. Plural folios abbreviated as foll., Ff, ff. 
 (2) In a papyrus manuscript, the recto is the side in which the horizontal fibres are 

uppermost, the verso the side in which the vertical fibres are uppermost. These are 
often indicated as 

 recto 50→ 
 verso 50↑ 
 Note that older works may use the terminology now applied to parchment and paper 

manuscripts also to papyri.  
 
*Gathering A set of sheets bound together at the centre as one of the units making up a codex (in 

the case of a single-quire codex, the only unit). The most common number of sheets 
is four, called a quaternion. The word quire is synonymous with gathering. 

 
Gloss Short explanation of a particular text added to the manuscript, usually in the margin 

(see also Scholia). These are recorded, marked as commentary readings 
([app][*][\*][K][\K][\app]). 

 
Example: G/A 1739, fol. 8r, Acts 7.43 

μολοχ in the text is explained in the margin with ειδωλον μωαβιτων 

 
*Gregory’s Rule  
 The general custom in production of parchment manuscripts of folding the sheets so 

that an opening contains two hair sides (which are darker) or two flesh sides. It was 
described by C.R. Gregory, Canon and Text of the New Testament, Edinburgh, 1907, 
323-5. (To be precise, Gregory’s Rule applies to the observation that Greek 
manuscripts contained quires of four sheets and ensured that the outermost side was 
flesh; but it is also used in this more general way.) 

 
*Group of manuscripts 
 At least two, but generally more manuscripts, which show clear signs of being 

closely related, but whose stemma cannot be reconstructed. 
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Haplography A type of copying mistake in which words, syllables, or letters that appear twice in 

the exemplar are copied only once (compare Dittography). 
   

Example: 1 Thess 2:7 
… εγενηθηµεν νηπιοι … εγενηθηµεν ηπιοι 

 
 
Homoeoarcton   

Means ‘identical beginnings’ and relates to the identical beginnings of words close to 
one another in a piece of text, such as αυτου and αυτων. This can mislead a copyist, 
looking back and forth between exemplar and copy, who can skip over verses or 
parts of verses, accidentally omitting what lies between two words with identical 
beginnings. 

 
Example: Homoeoarcton Acts 22.22 
ηκουον δε [αυτου αρχι τουτου του λογου 
και επηραν την φωνην] αυτων λεγοντες … 

 
Homoeoteleuton 

Means ‘identical endings’, and like homioarcton is a frequent cause of copyist error 
as the copyist’s eyes skip from the end of one word or sentence to another word with 
an identical ending, accidentally omitting what lies between them. 

 
Example: Homoeoteleuton Acts 22.22 
ηκουον δε αυτου [αρχι τουτου του] λογου 
και επηραν την φωνην αυτων λεγοντες … 

 
Hypodiairesis ‘Subtitles’ belong to the kephalaia (see Kephalaion). The υποδιαιρεσεισ are 

recorded in the kephalaia (chapters) lists and sometimes receive separate numbers as 
subsections. At other times there is no difference made between them and the 
kephalaia and they are numbered with them. Hypohaireses are transcribed in braces 
{…}. 

 
Hypothesis A summary of a document that is usually written directly before the document itself. 

In the case of catenae, the hypotheses are found at the beginning of the 
commentary.33 They are not transcribed. 

 
*Incipit (1) The standardised phrase introducing a lection intended to indicate the context (for 

example, ‘Jesus said’).  
(2) The opening half-dozen or so words of a writing used in identifying it. 
 

Inscription The title of a book, recorded at the beginning of the book. 
 

                                                             
33 A compilation of the hypotheses can be found in H. von Soden, Die Schriften des Neuen Testaments in ihrer ältesten 
erreichbarren Textgestalt hergestellt auf grund ihrer Textgeschichte, 4 vols (Göttingen, 1902-13) 1.300ff. 
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Examples of Inscriptions 
• αρχη του κατα μαρκον ευαγγελιου 
• πραξεις των αποστολων 
• του αγιου ιωαννου του θεολογου επιστολη καθολικη πρωτη 

 
Inscriptions are transcribed with any abbreviation written out in parentheses (…). 
They are given the block markers ‘chapter 0, verse 0’ (<K 0><V 0>). 
 

Isochronie When an omicron and omega are pronounced the same. 
 
*Itacism Strictly speaking, a spelling variation involving the letter iota, it is also used more 

generally for any kind of spelling variation where vowels or diphthongs are 
exchanged.  

  
 In addition to Parker’s Introduction: In New Testament and Byzantine Greek vowels 

and diphthongs were pronounced similarly which is how spelling variation involving 
vowels and diphthongs became so common. 

 
*K A siglum used by von Soden for the Byzantine text (K = Κοινή). Generally used with 

an added identifier, such as Kr for the most controlled form, or Kx for all manuscripts 
not classified. 

 
Kephalaion From at least the fourth century the NT texts were divided into sections called 

kephalaia (= chapters). These were given numbers, and later names. In the 
Apostolos, the kephalaia form part of the Euthalian apparatus (see above). The term 
‘kephalaia’ can be used to describe either the text passage or the chapter heading, 
also called ‘titlos’. 

 
Examples of Kephalaia 

  Chapter number, or kephalaion γ  

  Chapter heading, titlos, or kephalaion περι της προς εκαστον αγαπης 
αποστωπολημπτου κατα τον νομον 

 
*Lacuna A loss of text, usually caused by the material on which a manuscript was written 

having been lost. Sometimes it is due to the disappearance of ink. Plural ‘lacunae’.  
 
*Lectionary A manuscript containing the text of church lections rather than the full text of a 

writing, the readings being in their lectional sequence. 
 
Lectionary Notations 
 Additions to the text that indicate the liturgical use of a text passage, with the 

beginning and end of the reading normally marked by αρχη and τελος. 
  

Example of a Lectionary Notation 
τελ(ος) της ε´της λ´εβδ(αομαδος) 
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Frequently, the beginning of the lectionary reading will be repeated. This can result 
in a variation in the running text of a manuscript as the lectionary notation is 
incorporated into the text, for example, a passage might be introduced with αδελφοι 
μου or εν ταισ ημεραισ εκειναισ. Being of liturgical use only, these are not to be 
transcribed. 

 
The abbreviations (= υπαγε) and (= ζητει) are lectionary notations; they 
stipulate that the following text passage should be skipped during the reading. 

The abbreviation  (= σαββατον) is also a lectionary notation, and should be 
distinguished from a similar abbreviation  (= σημειωτεον), which is written in the 
margin to indicate something noteworthy (similar to the modern exclamation mark). 

 
*Lemma The passage of Scripture about to be discussed quoted at the beginning of a section 

in a commentary. 
 
Ligature Ligatures are formed when two or more letters are merged into a single character.  

Gardthausen provides some differentiation of ligatures: 
(1) Primary ligatures: two letters are written over each other so that they form one 
symbol, for example,  
(2) Secondary ligatures: two letters are not just externally joined, but one part of the 
first letter is simultaneously also part of the second letter, for example,  
(3) Tertiary ligatures: three or more letters are joined together into one inseparable 
unity, for example,  
Words with ligatures are transcribed in full. 

 
*Majuscule A Greek script written with each character written separately, the letter shapes 

generally conforming to the upper case equivalent in modern printed and written 
Greek. Sometimes in the past called uncial. 

 
Menologion A collection of readings for saints’ days and other special occasions. The readings 

begin on 1st September. The menologion is organised according to the names of the 
months (μην = month). In contrast to the menologion the synaxarion (see below) 
contains readings for all the church services of the church year. 

 
*Minuscule A compact Greek script developed in the ninth century, which combined certain 

letters in sequence and increasingly used ligatures and symbols representing 
commonly occurring sequences such as nominal and verbal endings. Also used of 
Latin manuscripts showing the same general characteristics. 

 
*Negative apparatus 

A critical apparatus in which only differences from the base text are cited, silence 
being taken to be agreement with the base. 
 

Nomina Sacra 
‘Sacred words’ written in abbreviated form with an overline above one or more 
letters. They are recorded in a transcription with an overline above the second letter. 
 



 44 

Obelos An obelos is a diacritical mark. It generally serves to indicate text that is present in 
the manuscript but which the scribe (or a corrector) thought should be deleted, for 
example, the Pericope Adulterae (John 7.53-8.11). Obeloi are not transcribed, but if 
they are present in a manuscript, their presence, and location (folio number), should 
be noted in the Status Note. 

 
Omission An absence of a text passage of any length, ranging from one letter to several 

chapters, which is due to scribal omission, not physical loss of part of the 
manuscript. Homoeoteleuton, for example, is one particular cause of omission. 

 
*Opening The two pages of a codex when it is opened flat, with verso on the left and recto on 

the right. 
 
*Opisthograph  

A roll which has been written on the outside. Usually only the inside carried writing. 
Such use of the outside usually constitutes the re-use of the roll once the text on the 
better side is no longer required. 

  
Pagination Unlike foliation (see Folio above), with pagination (Latin = paginae) the sides, not 

the leaves, are continuously numbered. The page number can be found in the upper 
or lower margin (usually the upper outside corner of a page) and may be written in 
either Greek or Arabic numerals. They should always be transcribed using Arabic 
numerals. 

 
*Palimpsest A manuscript which has been rewritten. The first writing (the underwriting) has been 

scraped off (Greek πάλιν (= ‘again’) and ψάω (= ‘scrape’) and a second (the 
overwriting) replaces it. Some manuscripts are overwritten twice; sometimes a new 
manuscript is made from the scraped leaves of more than one older manuscript. 

 
*Papyrus A writing material made from a reed of this name, and hence a manuscript written on 

this material. 
 
*Paratextual Textual material in a manuscript which is not a part of the text(s) which the 

manuscript transmits, such as running titles, page, quire or paragraph numbers. 
 
*Patristic citation 
 See Citation. 
 
*Positive apparatus 
 An apparatus is which differences from the base text and agreements with it are both 

given. 
 
*Quaternion See Gathering. 
 
*Quire See Gathering. 
 
*Received Text  

Most accurately applied to any printing of the text of the Greek New Testament as it 
was published by the Elzevir Brothers in 1633. It is also used generically of all such 
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texts, including its precursors, namely the editions of Erasmus, Stephanus and Beza. 
Often referred to in its Latin form as the Textus Receptus. 

 
*Recto See Folio. 
 
*Scholia (1) Comments or notes in the margin of a manuscript.  

(2) Excerpts from commentaries, placed in the margin of a copy of the text. 
 
In addition to Parker’s Introduction: The difference between scholia and glosses (see 
above) is not exact. In general, glosses are limited to an explanation of facts in as 
short a form as possible, whereas scholia offer something more like a commentary. 
Like glosses, scholia should be transcribed and marked as commentary readings 
([app][*][\*][K][\K][\app]). 

 
Section See Eusebian Apparatus 
 
*Siglum (Latin) The number, letter or abbreviation used to indicate a witness in an apparatus. 

Plural sigla. 
 
*Singular reading 
 A reading found in only one manuscript. 
 
Spatium The Latin term for spaces the width of at least two letters that have been left by the 

scribe. Even if the free space has later been filled in, for example by αρχη or τελος, 
it is still regarded as a spatium. These spaces are not recorded in a transcription. 

 
*Stemma A ‘family tree’ of manuscripts, showing how a family of known manuscripts is 

related, and what missing links (lost manuscripts) there are between them. 
 
Stichos According to Gardthausen34 the classical authors called στιχοι ‘raumzeilen’ or ‘space 

lines’ (in contrast to ‘sense lines’ = κωλα). Stichometric information, the number of 
stichoi or lines on a column or page assisted with the measuring of the length of a 
document, and thus also with the wages of the scribe. A count of the stichoi served 
as a check on the completeness of a document. This information is not transcribed. 

 
*Subscription  

A statement added at the end of a copy of a text, indicating what it is. Sometimes 
followed immediately by a statement of the next book. 
 
In addition to Parker’s Introduction: The subscription is to be recorded in the 
transcription. The subscription is given block markers consisting of a chapter 
number after the last chapter number of the work and the verse number 0 (for 
example, a subscription for Mark would be recorded as <K 17> <V 0>). 
 

Examples of Subscription 
• τελος του κατα μαρκον ευαγγελιου 
• πραξεις των αποστολων 

                                                             
34 V. Gardthausen, Griechische Palaeographie: Das Buchwesen im Altertum und im byzantinischen Mittelalter, 2nd edn, 
2 vols, (Leipzig, 1911-13) 2.72. 
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Examples of Subscription 
• προς τιτον της κρητων εκκλεσιας πρωτον επισκοπον εγραφη απο 

νικοπολεως της μακεδονιας 

 
 
*Sub-singular reading 
 A reading found in only two manuscripts. 
 
Supplement An addition to a manuscript of at least one entire leaf or (very rarely) part of a leaf, 

replacing original material. An important indicator of a supplement is a change of 
handwriting often accompanied by a change in the number of lines or columns. A 
supplement can occur anywhere, even at the very beginning of a manuscript.  

  
 If the handwriting changes in the middle of a regular page this information should be 

recorded in braces as a change of hands. It is not a supplement. 
 
*Surrogate A reproduction of a manuscript in photographic form (printed, microform, or digital 

image). A version available on the Internet may be from any of these three sources. 
 
Synaxarion A collection of readings for the regular church services of the liturgical calendar. In 

contrast to the menologion (see above) the synaxarion starts at Easter. It contains 
readings for each day of the year. 

 
Titlos A chapter heading (title) in which the contents of the relevant kephalaion or 

hypodiairesis (see above) are briefly summarised. In the kephalaia lists preceding the 
individual New Testament documents the titloi are listed with their associated 
kephalaia numbers. In addition, the titloi are often also repeated in the appropriate 
place in the text, usually in the upper or lower margin. The titloi are recorded in the 
transcription in braces {…}. 

 
*Tradent ‘A person or community that passes on the tradition of the Scriptural text’ (dela 

Cruz’s definition35). Used here to describe the role of a manuscript as a carrier of the 
text. 

 
*Transcription  

A word-for-word and letter-by-letter copy of a manuscript, usually preserving its 
page layout. It may be in either paper or electronic format. 

 
*Uncial A term denoting a type of Latin script, broadly analogous to Greek majuscule. 
 
*Verso  See Folio. 
 
 
 
 

                                                             
35 See 4.1 of Parker’s Introduction. 


